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SmartComputing’s Smarter Computing
Our presentation this month is smart computing tips from SmartComputing magazine.
The club in conjunction with SmartComputing (see Editor’s Ramblings) has provided
the club with 10 pages of helpful tips for all
operating system users primarily for XP users
though.
The presenter will be Bud Bondietti who
will demonstrate some of the tips as well as
show members a few fixes for those annoying little problems that arise.
The presentation will start at 7:30 p.m.
with the club’s question-answer Random
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Next Meeting
Thursday,
March 25,
Random Access SIG
6:30 p. m.
Meeting at 7:30 p. m.

Access SIG starting at 6:30 p.m.
The board has put together a nominating
committee for the upcoming year. For more
information about this committee see the
President’s Comment on page 3.
Almost every office is up for election this
time.
Want to run? Now’s your chance. Don’t
be bashful. Let the nominating committee
know. Or contact the committee to suggest
someone.
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Next board meeting
Come have dinner with the board at
6:30 p.m. Tuesday, April 6th, at
Ridgeway’s Restaurant, Modesto.

Be sure and check our web site at least once a week: www.mpcug.net
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Join The Modesto PC User Group
Web site: www.mpcug.net
To join MPCUG (or just get more information about us go to our Web site and fill out the new member
form or mail your check to: MPCUG, P.O. Box 5122, Modesto, CA 95352-5122.Membership is just $24 a
year and includes 12 issues of the PC Post along with participation in all meetings and events. You will
also receive e-mail advising you of extra events or news.

The PC Post and Editorial Policy
The PC Post is published 12 times per year and is available to all group members as a membership benefit. Annual
group membership dues are $24.
For information write:
Modesto PCUG PO Box 5122, Modesto, CA 95352-5122
Opinions expressed in the PC Post do not necessarily reflect the opinions or views of the members as a group or the
Board of Directors.
The PC Post encourages group members to submit articles
for publication. We would like to have articles which deal
with the writer’s experience with computer hardware and
software.
An article may deal with any computer-related subject
provided it contains no libelous or offensive material. We
can’t use information copied from other publications without
written permission except for quotes.
Articles should be submitted in MS Word text. Do not
spend time formatting your article such as indents or centering. Please use only one space between sentences. and do not
use bold, italicize or otherwise format the submission as we
can’t guarantee results in translation to Publisher. Proof read
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and run your spelling checker. Watch for special upper and
lower case in brand names. Do not tab or indent to layout text.
If you want to include a graphic, please contact the editor
for instructions.
We reserve the right to edit articles, for length or to improve readability. Longer articles may be published in several
parts. We will not knowingly promote unlicensed businesses.
Letters to the editor are encouraged. All articles and letters
to the editor should be submitted to the editor via email as an
attached file. Call him at 492-0391 before submission. Please
include your name, day and evening phone numbers, and
email address for contact.
The MPCUG exchanges some articles with other user
groups around the country via the Association of PC User
Groups (APCUG). If for any reason you object to having your
article distributed to APCUG member organizations for reprinting, please notify the editor at the time you submit the
article. Your wish will in no way affect publication of your
article in the Post.
Production notes: Prepared using Microsoft Publisher
2003, MS Office 2993, HP laser color printer and a lot of
sweat and tears.
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President’s Corner
By Sid Losher

The clubs nomination committee for the 20042005 year has been formed. The chairman is Jim
Goodman, jgood99@sbcglobal.net, with Linda Kerwood, tydebolsmom@fire2wire.com, and Terry Fix,
tfix@sbcglobal.net, serving as members. Contact any
of these three for suggestions for names for consideration for the MPCUG board. The offices up for
election are president, vice president and secretary.

The nomination committee needs to nominate one or
more candidates for each office and report at the
May meeting. Elections will be held at the June general meeting. I urge every member to give this some
thought. Your club is run by volunteers. It may be
time to “pay your dues” by helping to run the club.
Do not expect the same members year after year to
do this for you.

From the desk of the Member at Large
By Hank Mudge

I want to thank those who have been helping set
up and clean up after our general meetings. This is a
task that must be done each month. Several times if
it where not for those elected to the board it would
not have gotten done.
PLEASE if you can, we need at least four people

each month to commit to being at the meeting place
by 6 p.m. and the same number to remain after, so as
to accomplish this task.
If you are able to help please see me at the meeting and or call me at 529-1936.
We need you!

Membership Chairman
By Hank Mudge

Since we have started to provide the Post electronically, a question has arisen as to how the members are going to be reminded about when their dues
are due. After deliberation by the board, it was decided that the membership chairperson would be responsible for letting the members know when they
need to renew.

First notification will be via e-mail.
Should no response be received by the membership chairperson, then contact will be made by either
phone or mail. If after these actions (within a twomonth span), the member’s name will be brought to
the board for a decision on whether to drop the member.

Editor’s Ramblings
By Bud Bondietti

The board has created a new alliance with a computer magazine. SmartComputing has for years had a
working relationship with user groups like ours with
a membership in APCUG. The club will receive
credit for subscriptions to the magazine from club
members. When the club has amassed five subscriptions, it will receive a free one-year subscription
which can be used as a drawing prize, auction item
or whatever the club wants.
SmartComputing is a magazine geared to all types

of computer users from business to pleasure to hobbyist. In addition to timely articles, the magazine
has tips and hints to help make your computing life
easier. An added bonus to the magazine subscription is the SmartComputing website that subscribers can log onto and find additional information not
found in the magazine.
We will have a presentation about the magazine
and enrollment forms available at the meeting.

Be sure to check our website at www.mpcug.net for the latest information
Concerning the Modesto PC User Group.
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A boy and his computer Factoids
Retrieved from the Internet
1. Coca-Cola was originally green.
2. Every day more money is printed for Monopoly than the US Treasury.
3. It is possible to lead a cow upstairs but not
downstairs.
4. Smartest dogs: 1) Scottish Border collie; 2)
Poodle; 3) Golden retriever.
5. Dumbest: Afghan hound.
6. Hawaiian alphabet has 12 letters.
7. Men can read smaller print than women;
women can hear better.
8. Amount American Airlines saved in 1987 by
eliminating one olive from each salad
Served first class: $40,000
9. City with the most Rolls Royce's per capita:
Hong Kong
10. State with the highest percentage of people
who walk to work: Alaska
11. Percentage of Africa that is wilderness: 28%
12. Percentage of North America that is wilderness: 38%
13. Barbie's measurements if she were life size:
39-23-33
14. Average number of days a West German goes
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without washing his underwear: 7
15. Percentage of American men who say they
would marry the same woman if they had
It to do all over again: 80%
16. Percentage of American women who say
they'd marry the same man: 50%
17. Cost of raising a medium-size dog to the age
of eleven: $6,400
18. Average number of people airborne over the
US any given hour: 61,000.
19. Percentage of Americans who have visited
Disneyland/Disney World: 70%
20. Average life span of a major league baseball:
7 pitches.
21. Only President to win a Pulitzer: John F. Kennedy for Profiles in Courage
22. Intelligent people have more zinc and copper
in their hair.
23. The world's youngest parents were 8 and 9
and lived in China in 1910.
24. The youngest pope was 11 years old.
25. Iceland consumes more Coca-Cola per capita
than any other nation.
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Accessibility for Everyone
By Billy Mabray Oklahoma City PC Users Group eMonitor - February 2004
Many people, including a lot of Web designers, think
Website accessibility is only about making sites work for
blind users with screen reader software. Accessibility
should be about all of us. There is a wide range of physical conditions that can make using the Web difficult. The
Internet can be a frustrating place when you have poor
eyesight, colorblindness, or trouble using a mouse. You
may not fall into any of these categories right now, but
consider this statistic: 100% of Internet users are growing
older. At some point, we will all need help navigating the
Web.
There are many things that can be done to make the
Web more accessible. Some of those things are already
built into your Web browser. Others require Web designers to implement accessible features on their Web sites. If
you are one of the many people who has difficulty using
the Web, you will want to know what help is out there.
One of the biggest complaints people have is that text
is too small. It is also the easiest to remedy. If you are
using Internet Explorer, choose View>Text Size from the
top menu. Also, if your mouse has a scroll wheel, you can
hold the CTRL key and scroll up and down to change the
text size. Now, this will not work on all Web pages –
later, we will discuss why that is and what Web designers
can do about it. The Netscape/Mozilla browser, however,
can change text size on all Web pages. Choose
View>Increase Text Size, or hold CTRL and press the +
key.
There are many shortcut keys available for those who
have difficulty using a mouse. For example, the backspace key will take you to the previous page, F5 will reload your current page, and ALT plus the Home key will
take you to your home page (the page set to load when
you open your browser). Also, if you have gone back to a
previous page, ALT plus the right arrow will take you
forward again. Another useful key on any Web page is the
TAB key. You can use the TAB key (and SHIFT plus
TAB to go in reverse) to quickly navigate forward
through all the links and form fields on a Web page. Once
you have tabbed to a form element, other keyboard shortcuts may come in handy. For drop-down boxes, you can
use the up and down arrows to highlight your selection.
For radio buttons or checkboxes, use the space bar to select your choice. If you are using a recent version of Netscape/Mozilla, you can also use “Find As You Type.”
Start typing at any page and it will automatically do a
search for what you are typing on that page.
Some people, particularly the colorblind, find Web
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sites hard to use because the color of the text does not
contrast enough with the background colors. If the color
scheme of your favorite Web site makes it difficult to
read, you can override that as well. You will find this under Tools->Options or Edit->Preferences, depending on
your browser. You can set your default fonts, font sizes,
and page colors. You can also specify that your defaults
always override what is set by the Web page.
While these browser features can be helpful, there is
still much Web designers must do to make their site accessible to the widest possible audience. A good example
is text sizing. If Web designers use fixed text sizes – sizes
that specify an absolute unit of measurement, such as
points or pixels – on their pages, Internet Explorer users
cannot change their text size as I described earlier. Web
designers can, and should, use relative text sizes to make
their pages more accessible. Designers who prefer to use
absolute sizes for text should provide a “style switcher.”
This is a link on the page that allows the site's visitor to
make the text bigger and saves that preference in a
cookie.
Another accessibility feature that some designers use
is access keys. These are just like the shortcut keys I mentioned earlier; except they are defined by the Web page
you are on. For example, the designer could define ALT
plus 4 to take you directly to the search function. If you
visit a site regularly and know their access keys, they can
be useful.
Web designers should also use labels for forms. Labels
make the text next to a form field clickable, just like the
field itself. For example, if a form has a checkbox that
reads, “Click here to subscribe,” and that text is set as a
label, the user can click anywhere on that text to check
the box. It can be very helpful to have a larger target
when trying to click things with a mouse.
We still have a long way to go before the Web is accessible to everyone. But now you know some of the
helpful features you have at your fingertips already, and
you know what to ask for from the Web sites you frequent. Hopefully, as users learn what they can do, and
designers learn what they need to do, we can all enjoy the
Web a little more.
Billy Mabray and his wife, Angela, own Smart Goat, a local
software development and web design business. They are
members of the OKCPCUG. Comments or questions on the
article are welcome and can be addressed to:
billy@smartgoat.com.
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Claude’s Bytes
By Claude Delphia, editor emeritus
We all experience some degree of trouble understanding what various software programs do and
don't do. We pretty much understand what word
processors do, but graphics programs are a whole
different area of computing. They really aren't, for
the most part, based on text or numbers. This is a
small effort to give an overview of the differences
between various graphics software.
What's the difference between graphics programs? — Well to start off with, all graphics programs are not equal, even the ones that do basically
the same thing. For example, CorelDRAW and
Adobe Illustrator, two of the main "drawing" programs are similar in what they accomplish. But how
they do it is like the difference between a 1930's car
with manual transmission and a current car with
automatic. I don't mean the technologies are that different, but how you make each of these behave is
basically that different. While some of the differences are in usage terms and commands, most of the
differences are in approach. Suffice it to say, these
differences can't really be described here.
Unfortunately, that last statement is true of many
of the differences between the programs that are considered graphics software. Software designers seem
to have different approaches to the same thing and
then you add the factor of trying to be different fromthe competition, and you have a real mix- up.
Now back to the subject.
Drawing software is different from other software in the way it creates what you want, or see. It
is vector based, meaning, simplistically, that it is
based on drawing lines or curves. Someone asked
me recently why they couldn't find an eraser tool in a
particular program (It was a desk top publishing program which has similarities to drawing programs.)
You can't erase a portion or the middle of a line in
that type of graphics program. If you want to have a
line with a space in between at some point, you have
to break the line and create two with a space in between to achieve the broken line effect. The same is
true of a box or a circle or any irregular shape. It
must be broken into parts to create the blank space
you want.
In drawing programs, you really only have a computer simulation of a line. You can apply thickness
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and color to its description and then you will see the
effect on the screen. You can transform a line by
adding arrow heads or maybe other kinds of ends
depending on what the software features. But you
can't add a fuzzy irregular ending to the line unless
you go to some pretty special effects that are built
into many of these programs.
But in the end, mostly what you have is a mathematical description of what you see on the screen
and it must be dealt with that way. When you add
color or even textures to this mathematical description, your software decides how to fill the lined area
with what you've asked for.
Paint programs are the other software for creating something from a blank screen. Instead of lines
defining areas, a paint program deals with pixels and
their color and properties. Thus if you grab a paint
brush tool and you draw a line across the screen, it
just changes the pixels in that area as you move the
cursor. Thus you can come along with an erase tool,
which will turn those pixels back to what they were,
effectively breaking your drawn line. These lines
and images can also be very fuzzy edged or even
have some special texture built into the software.
One of the significant differences in what I just
described is that a drawing program starts from a
very precise point and then goes to the next point. A
paint program starts from an area of your screen and
changes the pixels as you move across the screen.
Instead of lines, you are just changing pixels to a
predetermined effect, such as paint brush.
Of course I'm deliberately making all of this simplistic so that you will "get" the basic differences.
For example, in a paint program, you can draw a box
or a circle and fill it with color just like the drawing
program. But you can't use a brush, or painting type
tool, in a drawing program.
Again keep in mind that these are generalizations
to explain concepts.
Desktop Publishing is another type of graphics
program and here things can get a bit sticky as you
start to involve word processing techniques with
drawing and graphic tools.
I remember my first experience with Adobe Page(See Claude on page 7)
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(Continued from page 6)

Maker at least 14 years ago. I had seen Adobe PageMaker demonstrated on the first Apple Mac when it
was first introduced. Remember those little square
boxes with the screen in the upper half? I didn't think
they were real business computers and the price was
way beyond even the horrendous expense of PC's in
those days — 1984 I think it was.
Well I was impressed with the ease with which
blocks of text could be manipulated and changed and
edited. But alas it was to be a number of years before I personally had the hardware and software to be
able to buy the first or second edition of PageMaker
for the PC. I can't remember whether this was before
Windows 3.1 or not.
When I bought it — it was at a computer show in
San Francisco, back when the shows took up the
whole San Francisco Mosconi Convention Center —
I brought it home and having paid a large sum, I installed it with some anxiety. What if it didn't work?
The disappointment would have been pretty great.
So I opened a blank screen. Hmmmm… Just a
blank screen. I tried to type something. Nothing
happened. I looked at all the menus and thought and
thought about what might be needed to get my text
onto the screen. Nothing worked. So it was RTFM,
(Read The Flipping Manual) time.
Low and behold, I learned my first major lesson
which is still true to this day. In order to put text
onto a page in a publishing layout, you must do one
of two things: either create a text block to type in, or
create a text start point using a text tool. This is basically true of all programs except word processing
and spreadsheets.
MS Publisher, for example, only allows you to
start in a text box. By default it presumes you are
going to type a bunch of text. Other programs allow
you to select a text tool and start typing wherever
you click on the screen. An some such as CorelDRAW, allow both techniques.
Back to PageMaker: once I learned about text being in a box, so to speak, it was all downhill as over
the years I learned many different aspects of manipulating text boxes, changing fonts and line spacing
within text boxes and otherwise being creative with
text.
I'm going to come back to Desktop Publishing but
next we need to deal with a third type of graphics
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software.
Photo editing programs are a totally different
bred than drawing or painting. If you work with
these programs, you will find that there are some
similarities between photo editing programs and
paint programs: both are based on pixel manipulation. But in general, their purposes, although they
may overlap slightly, are basically different.
Photo editing software is basically designed to
edit photos to make them look better or to achieve
some special effect that you couldn't do by just taking a picture. The latest photo editing software is
pretty sophisticated allowing you to seamlessly remove people and lighten and darken areas of the
photos.
In some ways, since this software is now probably
more common than drawing or painting software, I'm
not going to get into what it does.
So I'm going back to desktop publishing/page layout software and will add website design to the mix.
In many respects, this area is where all of the graphics programs come together.
In an average PC Post, you have many boxes of
text, which are manipulated in various appropriate
ways, from font styles andsizing and effects, to borders, spacing and positioning on a page. Desktop
publishing has special features such as auto text flow
from one box to another, from one page to many
pages. Auto text flow is a premier feature of desktop
publishing.
Overall, desktop publishing allows you to combine text areas with lines, boxes and add both artwork (graphics) and photos and manipulate all of
them in a mix on the pages. Of course another feature is that it allows for multi page publications to be
printed commercially or published as a PDF on the
Internet as the PC Post is now done.
Webpages are really the same thing although you are
not limited to paper sizes in your layouts. Webpages use
HTML to put all the graphics and text together and there
are limitations that don't exist in desktop publishing layout wise. But then webpages have motion and photos that
would not be possible in the average desktop publishing
situation.
While you can do some limited drawing in a desktop
publishing program — simple lines boxes or circles — it
is not designed for this purpose. For example, if you want
(See Claude on page 8)
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Buying a LCD monitor
By Jim Goodman, MPCUG Webmaster
Price, looks and specifications depend on your
budget.
Buying a monitor with speakers: Never. If you
want good sound, buy a set of speakers with a subwoofer. Some motherboards will support Dolby
Digital 5.1 or better.
The main problem many people have with LCD
monitors is that these monitors are not sized in the
same fashion as a standard CRT. A 17-inch LCD
monitor has 17 inches (diagonal) of viewable space,
while a 17-inch CRT will have generally about 15.7
to 16 inches (diagonal) of viewable space. This
leads to some confusion when going to purchase an
LCD display.
When looking at a 19-inch LCD screen, you perceive it as massive. Compared to a 19-inch CRT, the
screen size alone is almost bigger than the casing of
the CRT. This is rather nice, since you can sit well
back from the screen and still read it. For those getting on in years, a large-panel LCD may be just what
they are looking for. No more squinting while trying
to read emails.
Also, another nice thing about LCD monitors is the
weight. A 19-inch CRT will weigh around 50 to 57
pounds, while an LCD monitor is around 15 to 18
pounds.
When you buy an LCD monitor, you need to do
your homework: some models will have only a15-pin
mini D-sub analog connector; others will have SVideo, TV Tuner Built-In.
Buy a monitor with both an analog RGB and DVI
(Digital Video Interactive) connection. You may
need a video card with a DVI output.
All flat screen monitors have a fixed resolution.
Close to 99.9 percent of all 17-, 18- and 19-inch
(Claude continued from page 7)

to create a map, you are better off going to a drawing or
painting program to create it. If you use a painting program, you can then erase portions of the image.
The image you create then has to be imported or inserted into your publishing layout.
The boxes around text, and the lines that separate
blocks of text, as well as some borders do use vector images as far as I understand it. How these page layout programs manipulate decorative borders is something I'm not
clear on although I suspect that they are vector (line and
fill) generated; otherwise how would they be able to be
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monitors have the same fixed resolution -- SXGA
1280X1024.
The monitor will look the best if you run the
monitor in the monitor’s fixed resolution.
A 17-inch monitor with a fixed resolution of 1280
X 1024 is going to be harder to read then a 19-inch
monitor.
If you have any type of eye problems, buy a 19inch LCD; it may cost a few dollars more but everything will be larger, and no more eye strain.
Brightness: 250- 300- 350 - 400 nits or cd/m2
(candela per square meter) Higher is better.
(A unit of measurement of luminance, or the intensity of visible light, where one nit is equal to one
candela per square meter. Nits are used to describe
the brightness of computer displays, such as LCD)
Contrast Ratio: 300:1, 400:1, 500:1, 600:1,
700:1
Difference between the pixels going from light to
dark. The higher the contrast ratio the more crisp the
screen will look. Higher is better.
Response Times: are in ms (milliseconds) look
for 25 – 16 - 12ms.
How fast the pixels can go from black to white.
Playing back video, motion, games, etc. Lower is
better
Dead Pixels: There is still the recurring issue of
dead pixels.
Acer only replaces its 19-inch monitors when there
are 10 dead pixels.
spaced around so many different sized blocks of text. MS
Publisher allows you to create your own border from
graphics, so those aren't vector images.
Oddly enough, PageMaker for the PC was always way
behind in it's ability to create borders. You were limited
to lines of various styles, but no special graphic corners,
etc.
The bottom line is that desktop publishing allows you
to take things you've created in word processors, drawing
programs, paint programs and photo editing programs and
combine them by placing and moving them within the
print area of your publication.
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The Club’s
Meeting Place

Free classifieds for members. Email the text
to the editor at Editor@mpcug.net

Our General Meetings and the Random Access
Special Interest Group is held in the gym behind St.
Paul’s Episcopal Church, 1528 Oakdale Road, Modesto
(between Briggsmore and Orangeburg, north of Century
Center). The church faces Oakdale Road and the gym
faces St. Paul’s Way.

Cyrano Writing & Editing
When you need help putting it in words, call Cyrano.

(209) 523-4218; 499-5401

For Information about our website host
and how you can get on board:
Click on this link info@fire2wire.com

Resumes, letters, applications,
articles, newsletters,
press releases, theses
Elizabeth Leedom
eleedom@sbcglobal.net

Need help hooking up
that new PC,
or installing DSL-Cable?
Reasonable Website setup
and design
209-537-9604

Call Jim Goodman, $50 for as
long as it takes. 579-0122
jgood99@sbcglobal.net
Modesto, Ceres Area

Claude Delphia, publisher, 209-537-9604

Be sure and check our web site at least once a week: www.mpcug.net
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Special Interest Groups
SIG meetings are held at the discretion of the leader and participants.
Sometimes the date, location and time have to be changed or a meeting
cancelled. Give the leader a call before the meeting if it is your first
time. Call Bud Bondietti if you know of changes — phone 667-1980 or
email sig@mpcug.net.
SIG Name

Leaders

Phone#

Date / Time / Note

Beginners’ SIG.. Bud Bondietti ........ 667-1980.....6:30 p.m., 2nd Monday, Denny’s 1525 McHenry Ave.
Q&A.................. ............................... ....................6:30 p.m. before general meeting
Genealogy SIG .. C. Delphia ............. 537-9604.....On hiatus
Board Meeting... Sid Losher ............. 545-0853.....6:30 p.m., 1st Tues. after gen. mtg. Call for place.
Website SIG ...... Jim Goodman ........ 579-0122.....Looking for a place to meet.
Women's’ SIG….Liz Leedom………523-4218….Contact for meeting location and time

Membership renewal: As with all organizations, MPCUG is run solely by volunteers. That means that when your
membership comes due, someone must send you a reminder, sometimes several times. We try to cut back that need
by printing your expiration date and a message on your mailing label letting you know your membership status.
Please help by renewing your membership in a timely manor. It saves user group money and volunteer time.

Please check your label for expiration date and message
PC POST
Modesto PC User Group
P.O. BOX 5122
Modesto, CA 95352-5122

RETURN SERVICE REQUESTED

Time dated material
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